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I recently sat down with Jeremy, president 

and CEO of Vermont computing to find out 

a little more about what is going on at VCI. 

“Right now the focus is on new PCs, and 

the domain name buyavcpc.com. We have 

a new line of VCPCs—same price, but a 

better computer. So our focus right now is 

on PC sales.” 

In conjunction with this focus on PC sales, 

a kiosk has been placed in the store where 

customers may sit and configure their own 

VCPC. Online sales manager, Matt La 

France recently added an “in-store-pickup” 

item to the shipping options. Customers 

who configure a machine in the store, or 

from their homes, can opt to pick the ma-

chine up at the store when it’s finished. It 

also allows customers to select from a 

wider range of add-ons and peripherals 

than what’s available in the store, at special 

online-only prices. 

I also spoke with Jeremy about his new of-

fice at Vermont Technical College’s Enter-

prise Center on Rt. 66. Jeremy said, 

“It allows the staff more room at our current 

location and allows me to focus on things 

and be more productive. And I’m sure the 

staff is happier without me around all the 

time, ha-ha. But seriously, before I only had 

things in two places, my home and the 

store, and now there are three places so it’s 

harder to keep track of everything, but it 

let’s me focus on my projects.” 

 

Jeremy knew others that had space in the 

building and is happy he was able to make 

the move from the retail store to this new 

location.  

I also got a chance to chat with service 

manager Ian Stewart about drop-off/pick-up 

points. 

“What we are planning is setting up a pick 

up point where customers can drop equip-

ment at a location that is convenient for 

them, rather than driving to Randolph to 

drop their PC off at the shop.” 

This drop-off point will be coming to the 

Barre/Montpelier area initially. The way it 

works is a customer will go to the drop-

point, which will be at a related store such 

as an electronics store, fill out the paper 

work, and drop off their machine. VCI will 

get notified by the operator, and come pick 

up any machines on a schedule every cou-

ple of days. The customer will be contacted 

and the PC will be worked on in the office. 

When finished, the customer will pay over 

the phone with a credit card, or by mail with 

a check. Once paid for, the machine is 

taken back to drop-off point where the cus-

tomer can pick it up. 

This will allow customers to take advantage 

of the great service that VCI offers, without 

the inconvenience of driving outside of their 

local area. For customers who are not in 

the immediate area this will be a huge time 

saver. The specific drop-off point has not 

been finalized yet, but will be coming soon. 

Jeremy gets a new office, New Drop-off/Pick-up Point 
forthcoming, Build a VCPC kiosk/BuyaVCPC.com 

By, Matt La France 
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Automatically set Processor Affinity in Windows 

XP Professional 

http://articles.techrepublic.com.com/5100-10877-

6168870.html 

If you have a dual-core processor, you may discover 

that certain older applications that ran fine on sys-

tems with a single core CPU have problems running 

with two cores. For example, your application may 

suddenly begin maxing out the CPU usage at 100 

percent, appearing to lock up. Windows XP Profes-

sional's Processor Affinity setting allows you to work 

around such problems by configuring older applica-

tions to use only one of the cores. Here's how to set 

it up: 

1. Access Task Manager.  

2. Choose the Processes tab.  

3. Right-click the process associated with the prob-

lem application.  

4. Select the Set Affinity command. (If you don't have 

a dual-core system, you won't see the Set Affinity 

command.)  

5. From the Processor Affinity dialog box, clear one 

of the CPU check boxes. 

You could perform this manual operation every time 

you run the application, but the THG Task Assign-

ment Manager (available for download from Tom's 

Hardware) allows you to create profiles that automati-

cally assign applications to a specific CPU every time 

you run them. 

Remove clutter with Windows XP SP2's Duplicate 

Finder tool 

http://articles.techrepublic.com.com/5100-10877-

6160661.html 

Even if you're a conscientious computer user (i.e., you 

regularly delete unnecessary files, empty the Recycle 

Bin, and run Disk Defragmenter), you may be unaware 

of a potentially big waster of hard disk space: duplicate 

files. Applications can litter your hard disk with duplicate 

files, or you can actually create duplicate files by copy-

ing files from one folder to another. 

Windows XP's default installation doesn't provide you 

with a decent utility for tracking down duplicate files. 

However, Microsoft does have a tool called Duplicate 

Finder, which is part of the Windows XP Service Pack 2 

Support Tools. Here's how to install and use the Dupli-

cate Finder tool: 

1. Download the Windows XP Service Pack 2 Support 

Tools and follow the instructions for installing the Com-

plete installation version.  

2. Open the Run dialog box by pressing [Windows]R.  

3. Type Dupfinder in the Open text box and click OK.  

4. Once DupFinder loads, simply select the drive or 

folder to search and then click the Start Search button.  

5. When DupFinder completes its search, you can scan 

through the list and examine the duplicate files. 

Here are tips for working with the list of duplicate files: 

Use either the Print Report or Export Data commands 

on the File menu to create a permanent record of the 

duplicate files.  

Use the Sort command on the View menu to reorganize 

the list for better analysis.  

To get more detailed information about any file, select 

the file, pull down the File menu, and select the Info 

command.  

Leave duplicate files in the Windows folder and its sub-

folders alone.  

If you don't recognize the duplicate file, it's better to use 

the Rename or Move commands on the File menu 

rather than the Delete command. 

Note: This tip applies to both Windows XP Home and 

Windows XP Professional. 
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Quad-Core Processors to Go Mainstream by 2009  

http://www.extremetech.com/article2/0,1697,2115129,00.asp 

By the end of 2009, today's high-end quad-core processors will 

eventually appear in close to half of all mainstream desktop sys-

tems, according to new data released by market research firm 

iSuppli on Tuesday.  

Intel's current Core 2 Quad and Advanced Micro Devices' forth-

coming quad-core processors-all of which combine four processor 

cores into a single silicon die-are still hampered by high costs and 

limited availability, iSuppli said... 

...But that is expected to dramatically change over the next two 

years as quad-core microprocessor technology gradually begins 

to penetrate the mainstream desktop PC segment.  

iSuppli says that while no mainstream desktop PCs will ship with 

quad-core microprocessors in the first half of 2007, quad-core 

penetration in mainstream desktop PCs will rise to 5 percent by 

the third quarter of 2007, and then to 7 percent by the fourth quar-

ter.  

In fact, that penetration will continue to increase in the following 

months, according to the firm, hitting 18 percent in the fourth quar-

ter of 2008, and then rocketing to nearly half of the market (49 

percent) in the fourth quarter of 2009.  

"Quad-core microprocessor technology is coming to the main-

stream, and with it is coming capabilities that presently are re-

served only for high-end systems," said Matthew Wilkins, principal 

analyst for computer platforms at iSuppli, in a statement on Tues-

day.  

"It will allow users to do more tasks simultaneously, but now, the 

'more' can be converting videos, burning DVDs, playing complex 

3D games, or ripping music-all at once-and still have performance 

to spare," Wilkins continued. "To put this into context, a quad-

core-based PC is very similar to a quad-microprocessor system 

from the pre-multicore era, such as a workstation or server, which 

would have been very high-end system, priced well in excess of 

$10,000. "  

iSuppli says it defines mainstream desktop PCs as "those having 

the most common specification and functionality available, and 

that are priced between $500 and $1000." In the first quarter of 

2007, mainstream PCs accounted for 42 percent of total desktop 

computer shipments, iSuppli said.  

The low-end "value" desktop PCs are not expected to make any 

use of quad-core microprocessor technology over the next two 

years, according to iSuppli... 

AMD Outlines Restructuring Plan After Loss  

http://www.extremetech.com/article2/0,1697,2118958,00.asp 

Advanced Micro Devices reported dramatic losses in first quarter 

revenues, which executives called unacceptable. AMD also deliv-

ered a rough draft of a restructuring plan that will return the com-

pany to its former status, executives said.  

AMD recorded operating and net losses of $504 and $611 million, 

respectively, or $1.11 per share. AMD recorded revenue of $1.23 

billion, down 30 percent from the fourth quarter and 7 percent 

from a year ago...  

...According to the company's executives, the plan is fairly 

straightforward. "We need to grow the top line, change our cost 

structure in line with the competitive environment, and execute 

flawlessly on our product and technology roadmaps," Meyer said.  

In order to do that, AMD will be accelerating some of its initiatives, 

including simplifying its sales and marketing organization in order 

to improve its responsiveness to customer demand, restore its 

value proposition in the channel and refocusing marketing spend-

ing on demand generation programs, and also increase its em-

phasis on acquiring new customers and broadening our portfolio 

with existing customers.  

Meyer also said that while the company knows it can't cut its way 

to prosperity, there will need to be "some significant adjustments 

to its business model" - in other words, layoffs.  

"…We're reassessing our overall staffing plans," Meyer said. 

"Specifically, we're going to limit ourselves solely to critical hires, 

and to the extent that we add resources, we'll focus primarily on 

doing so in lower cost geographies."… 

Broad Patents Threaten to Stifle Innovation  

http://www.eweek.com/article2/0,1895,2119425,00.asp 

...Vonage faces potential bankruptcy following the patent lawsuit 

defeat recently dealt to it by telephone services incumbent Veri-

zon, and considering how liberally the United States Patent and 

Trademark Office hands out monopolies over the basic ideas on 

which upstarts such as Vonage build their businesses, Vonage 

certainly won't be the last business innovator to find itself so en-

dangered.  

As with so many software and business method patents that grab 

industry headlines, the patents that Baby Bell Verizon is wielding 

against Vonage have an odor of obviousness. Today's Internet 

was born in the context of our telephone networks, so there was 

nothing particularly earthshaking about adapting voice traffic to 

flow from the circuit-switched networks of classic telephony to the 

packet-switched networks of what would become the Internet. 

Indeed, today's VOIP technology is rooted in the Network Voice 

Protocol first implemented in 1973.  

...Bill Gates once famously pointed out that "If people had under-

stood how patents would be granted when most of today's ideas 

were invented and had taken out patents, the industry would be at 

a complete standstill today."  

...Rather than waiting in vain for government leaders to check 

patent overgrowth enough to carve out a space in which entrepre-

neurs may operate, perhaps the IT vendors who stand to profit 

from tomorrow's start-ups by providing them with the development 

tools, platforms, and components on which they'll build will see 

the value of carving out that space on our behalf... 


